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Part 1 : Introduction 

What is EndNote? 

 

EndNote is a reference management software package, which is used to manage 
bibliographies and references when writing theses, essays and articles. The software is 
available for both PC and Mac. 
 

EndNote allows you to: 

o Store all the references that you find during your research. They can be entered 
manually or downloaded from most databases.  

o Store PDF files, pictures, graphs, tables, etc. 
o Add citations to your work and create bibliographies in any output style (e.g. APA, 

Chicago, MLA, and Vancouver). There are 5,000 styles to choose from. 
 

How to obtain EndNote 

 

EndNote X7 is available on all PCs in the University’s open access PC suites. 
If you wish to obtain EndNote X7 for a ‘personal’ University-networked PC in an office or 
postgraduate room: 

o Email its-servicedesk@salford.ac.uk and ask to be put on the EndNote User Group.  
o You need to tell them your network username and University of Salford email address.  
o If you require EndNote for Macintosh include this in your email to ITS Service Desk 

too. 
o You will then be sent instructions on how to download the software onto your 

computer. 
o Note:  if you have an earlier version of EndNote you should uninstall it before installing 

EndNote X7. 
 

EndNote for home use 

 

As a member of Salford University, you are able to purchase a copy of the EndNote software 
for home use at a substantially discounted price. 
 

o Go to: http://www.adeptscience.co.uk/a4e/ 
o Click the Login Now button.  

 If you are using a University of Salford PC you will automatically be recognised as a 
member of the University.  

 If you are using a PC off-campus (e.g. at home) you can access the store by 
following the on-screen instructions to select your institution and type in your 
Athens username and password. 

o Choose the option you want (Windows or Mac). It is recommended that you choose a 
DELIVERY option, rather than one for immediate download. This way you will have the 
software on a CD, should you wish to install it on another machine.  

o Your licence allows you to install EndNote up to three times. 

mailto:its-servicedesk@salford.ac.uk
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EndNote Basic 

 

EndNote Basic is a Web version of EndNote, which you may prefer to use off-campus. This is 
a lot less sophisticated than EndNote X7, but it is FREE.  
 
Groups of records can be transferred easily between EndNote X7 and EndNote Basic, so you 
may choose to use the full software when you are University and the Web version when you 
are at home. It is highly recommended that you use EndNote Basic to back up your EndNote 
references. You can also use EndNote Basic to share references and work collaboratively 
with others. Please see p. 8 for information about EndNote Sync. 
 
For more information please see the separate EndNote Web guide, available at: 
http://www.library.salford.ac.uk/help/userguides/general/endnoteweb.pdf 

 
 

Part 2 : The EndNote Library 

An introduction to EndNote libraries 

 

o EndNote references are stored in a database called a Library. EndNote libraries 
have the file extension .enl.  

 
 

o Each library has a corresponding folder with the extension .Data. This folder 
will have the same name as the library, and it is where images, PDF files, etc. are 
stored. If you move, copy, rename or delete a Library remember to do the same 
with its corresponding .Data folder. 
 

o There is no limit to the number of references you can store in a Library, although it is 
recommended that you do not exceed 100,000 to maintain efficient performance of the 
database. 

 
o Although the software allows you to create as many Libraries as you wish, it is strongly 

recommended that you keep all your references in just one Library. This way you will 
know where to find them, and will no create duplicate records in other Libraries. 

 
o Within your library you can create Groups (or subsets) to help you organise your 

references. Custom Groups are manually created by drag-and-dropping to copy references 
into a group. Smart Groups use search criteria to dynamically update groups as existing 
references are edited or new references are added to the Library.  

 
o Each EndNote record stores the information required to reference it in a bibliography. 

Other information, to help you with your research, such as keywords, notes, abstracts 
and URLs can be stored in a record as well. You can also attach PDF files and images to 
EndNote records, and you can annotate PDFs with highlights and your own comments. 
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Library overview 

 

 

 

The EndNote Library screen is split into three panes: a Reference List pane, a Groups pane, 
and a Tab pane.  
 

 
 
 
The above layout is recommended if you have a wide-screen monitor. 
 
For a conventional monitor you might prefer a layout like this  

Click the Question Mark (?) icon to 

go to EndNote Help. 

 

The Reference List Pane. 
This shows a list of all your references, each 
displayed as a single line. 
 
You can sort the references by clicking on a 
column heading. 

Go to File then New to make a new library, or 

Open to open an existing library. 

 

The Groups Pane. 
These are subsets (or folders) of 
references saved for easy retrieval. 
Click on the title of a group to see its 
contents displayed in the Reference 
List pane. 

The Tabs Pane. 
This includes tabs to three commonly used functions – 
Reference, Preview and Attached PDF. 

Click the Layout 
button and select 
Bottom. 
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Reference overview 

 

 

To see all the details for a reference you can either use the Reference tab, or 
double-click on it in the Reference List pane. 

 

Each reference has its own unique number. EndNote 
uses these numbers for formatting, and they cannot 
be changed. 
 

The font and size should both be set as Plain, unless 
you need a special style for a character. You do NOT 
need to set italics or bold; EndNote will do this for you. 
 

Use the Aa button if you 
need to change case – 
for example, for titles 
imported all in capitals. 

As well as the fields that are required to 
format your bibliography, EndNote provides a 
number of fields for your own use, for 
example, to write your own research notes, 
and attach files and images.  
How you use these fields is your own choice. 

Use the Options button 
to hide or display empty 
fields in the record, and 
display the Ratings tool. 

When you are typing in numbers, 
for example, for pages or 
volumes, you do not need to type 
v. or pp. before them – just the 
numbers. 
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EndNote X7 has fifty predefined  
Reference Types to choose from. 
 
Records imported automatically 
from databases will usually have the 
correct  Reference Type selected, 
but occasionally you will need to 
change it to achieve a better 
citation. 
 

 

 

 

 

 

 
 

EndNote has some features to help with your information management. 
 
When you import records into EndNote they will be displayed in bold (unread). To help you 
keep track of your workload you can mark records when you have read them, and also assign 
a rating to remind yourself how useful you found the paper. 
 

 

 If you are manually inputting references, you need to 
select the correct Reference Type for the type of 
publication you are citing. This will ensure the correct 
information and format appears in your bibliography. 

When you have finished editing a 
record, click the small X close button.  
This will save any changes you have 
made to it. 

Click the status button to mark 
when you have read an article. 

Use the Rating tool to mark how useful you have found a 
paper. You can either click here to assign stars, or do this in the 
Rating field within the open record (see p. 5). 

The paperclip indicates that a file 
has been attached to the record. 
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Preferences  

 

There are number of ways you can customise EndNote to suit your own needs.  
 
Go to the Edit menu and select Preferences. 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To find out more about the options available to you go to EndNote Help: 

o Select Preferences, Toolbars & Shortcuts from the menu,  

o then EndNote Preferences. 

 

 

 

Click on the item in 
the menu to see 
what options are 
available – for 
example, you might 
wish to change the 
font of your display 
screen, or select 
which columns are 
displayed. 

If you make a mess of your preference changes you 
can click the EndNote Defaults button to return 
everything to the way it was. 

Use PDF Handling to give your 
PDF attachments meangful 
filenames, and to set up an 
automatic import folder.  
See pages 19 and 23 for more 
about this. 
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Creating your own EndNote library 

 

o Go to the File menu and select New. 
o Give your Library a name and save it to your F: drive. Note that it must be saved as 

EndNote Library (*.enl). 
o Your new Library will have been created and will open automatically. 
 

EndNote Sync 

 

It is highly recommended that you use EndNote Web (Basic, see p. 3) to make a back-up of 
your EndNote Library.  
 
Before you start, one of your Libraries (web or software) should be empty – therefore it is a 
good idea to set this up before you start saving records. 
 
Go to Preferences (see p. 7). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Whenever you close your EndNote Library, all the references in it will be backed up to your  
Web Library, ready for you to use when you get home – or anywhere else you have internet 
access. What’s more, your references will stay there forever (even after you have left 
Salford), until you choose to delete them. 

Click the Sync link, then the Enable Sync 
button. 
 
Follow the on-screen instructions to 
make yourself a EndNote Basic account. 
 

Once you have made an account, 
enter your email address and 
EndNote password here. 
 
(If you already have an EndNote 
Web account you can use that.) 
 

Tick the Sync Automatically box, 
then click the OK button. 
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Adding references manually 

 
Usually, references will be added to your Library by importing them directly from online 
databases, but occasionally you will need to make a manual record – for example, for a 
webpage, blog or unpublished report which doesn’t have an electronic record for it. 

Sometimes, you will also need to edit records that you have imported from databases. 

 

 

 

 

 

 

 

 
 

Click the New References button. 

 

A blank form will be displayed. 

Select the correct Reference Type for the publication 
you wish to cite (see p. 6).  

Type the information into the relevant fields.  
Most of the fields you need to produce an 
adequate citation are towards the top of the 
page.  
Many of the fields are provided to help you 
organise your research, make useful notes, 
etc.  
You don’t have to fill them all in. 
 

When you have finished 
entering all the information, 
click on the small cross  
(not the red one) to save the 
reference. 
 

See the next page for 
advice about 
entering authors. 
 

These should be set to Plain Font and Plain Size unless you 
need a special character. Remember that EndNote will do 
any standard formatting automatically. 
 

Use the Scroll Bar or 
arrows to display 
more fields. 
 



 
11 

 Author & editor names 

 

When you have more than one author or editor, each of their names 

should be typed on a separate line, i.e. press the <Enter> key after each 

name.  

 
Personal authors & editors 
o Author names should be entered with the last name followed by a comma and the first 

name (or initials), e.g. Smith, John or de Gaulle, Charles  
 
o You must type capital letters where required,  

e.g. Smith, John  (not smith, john) or van der Voordt, Theo 
EndNote cannot guess where capital letters are or are not used in names.  

 
o If you are entering initials instead of full names, be sure to type a full stop or a space 

between initials, (for example "Fisher, J.O." or "J O Fisher"), otherwise EndNote 
interprets the initials as a single name: "Jo." 

o Wherever possible, use full names. 
 
Corporate authors 
o When entering corporate authors (companies, institutions, organisations, etc.), put a 

comma after the name, for example:    
University of Salford, 

o This ensures it will be correctly formatted by EndNote. 
o If your corporate author name includes a comma in the name itself, use two commas in 

place of the first comma, for example: 
Institute for Social Research,, University of Salford 

 
Anonymous works 
o If a reference has no author, you should leave the Author field blank. Do not enter 

"Anonymous." The style that you use to format the bibliography determines how 
anonymous references are treated.  

o Note that if a work is published with "Anonymous" printed on the title page, most style 
guides request that "Anonymous" be entered as though it were the author name – in 
which case you should type Anonymous into the author field. 

 
Using et al., etc. 
o Enter all author names for a particular reference. EndNote will truncate the list of authors 

with "et al." or "and others" as required by the citation style you have chosen. 
o If you do not know all of the authors’ names, then the last author should be "et al." or 

"and others" followed by a comma, e.g. et al., 
 
 
New entries for Authors, Editors, Journal Titles and Keywords will appear in red. EndNote has 
an auto-complete function which will complete the typing the next time you use that author, 
etc. 



 
12 

Attaching images 

 
EndNote allows you to embed images, figures, tables, charts, etc. into your references. This 
is a useful way to store any graphic material you find in the course of your research. 
 
You can insert a graphic file into the Figure field of any EndNote reference. So, while a 
reference to a journal may contain primarily bibliographic information, you can also include 
an illustration that appeared with the journal article. 
 
The Figure, Chart or Table, and Equation reference types can be used specifically to catalogue 
images and files, and may contain minimal reference information. EndNote can then be used 
to insert figures and format a list of figures (if appropriate) in your paper. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
  
 
 
 
 
 
 
 
 
Remember that if you are using images in your writing you must provide a caption for each 
one, and this must include a citation for the source of the image (as in the above illustration). 
You can find out more about this in the guide “Referencing Images” which is available on the 
Library’s website at:  
http://www.salford.ac.uk/library/help/userguides 

Open the record you wish to use, then click the 
Attach Figure (drawing pin) icon. 

Scroll down the reference screen to see 
your image. 

Double-click on it to see the full-sized 
image. 

 

 

Add a caption to 
describe the image. 

 

Click the Choose 
File button and 
browse to 
where you have 
the image 
saved. 

 Click the OK 
button. 
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Part 3 : Importing Records from Databases 
 
When you search databases to find journal articles, books and other information it is usually 
possible to import the records you find directly into EndNote. This has the advantage of 
allowing you to import references accurately without having to re-type all the information 
yourself. 
 
Most databases contain a download or export button that will send your search results 
directly to EndNote, pick the correct import option, and start the import process 
automatically. All you need to do is choose the EndNote library into which the data should be 
imported. 
 
In a few databases importing records is a two-step process where you save the results of 
your search into a file, then import that file into your EndNote library using an Import Filter. 
 

 
 
Please note that with some databases it is not possible to import references automatically 
into EndNote. In these cases you will need to either type the information in manually or copy 
and paste it into the appropriate reference form, following the instructions on pages 9 & 10 
of this guide. 
 
 
 

 
 
 
 

For instructions about how to import records into EndNote from the databases provided by 
the Library, please see the separate guide: “Instructions for Downloading from Databases 
into EndNote”, available at: 

http://www.library.salford.ac.uk/training/workbooks/endnotedwnld.pdf 

 

Note: Before you try to import any records into EndNote you should 
make sure you have your reference list displayed – like this. 
 

Close any references you have open. 
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Importing references from Web of Knowledge 

 
1. Open Internet Explorer, go to the Student Channel and click the SOLAR Library 

Search link. 
2. Click the Databases link, then the letter W, then the Web of Knowledge link. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

3.  Type in your keywords and 
click the Search button. 

4.  At the results 
screen, tick some of 
the checkboxes next 
to the results you 
want. 

5.  Scroll down to the bottom of 
the page. 

6.  Tick the plus Abstract box. 
7.   Click the EndNote button. 
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8.  Depending on the security settings of your PC, you may 
see a message like this.  
If you do, right-click on it and select Download File. 
 
If you do not already have your EndNote library open you 
will be asked to select the library you want to use. 

9.  Return to your EndNote library. Note that the references you have 
just downloaded are in a Group called Imported References.  

10.  Open one of the records to 
see the information that has 
been imported. 
 
It is always a good idea to open 
each reference and check that 
the information has been 
imported correctly, while you 
still have the database open. 
This will make it easier to 
correct errors immediately. 
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Editing records 

 

Sometimes the records you import will have titles all in capital letters, or with each word 

capitalised. This will create incorrectly formatted references in your bibliography, so you will 

need to edit these records. 

  

 

 

 

The above reference will now be correctly formatted, as such: 

 

Remember to replace capital letters for any proper nouns! 

Open the record and 
highlight the text you 
wish to correct. 

Click the Change Case button and make your selection. 
 
As a general rule, article and chapter titles are in sentence 
case, i.e. capital letter for the first word and proper nouns 
only. 
Book and journal titles usually have a capital letter for all the 
main words. 
 



 
17 

Importing references from EBSCO 

 
 
o Open Internet Explorer. 
o Go to http://search.ebscohost.com/ 
 
 
 
 
 
 

 

 

  

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

Click the All other EBSCO 

databases link. 

We subscribe to a number of EBSCO databases which 
cover different subject areas and include many fulltext 
articles. 
Click the title link for the one you wish to search. 
 
If you’re not sure where to start, select Academic Search 
Premier, as this database covers a wide range of 
subjects. 

Type in your search terms, then click the Search button. 

At the results page, click the 
Add to folder link for each of 
the references you want to 
save. 
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Remember to check that the information that you have just imported into EndNote is correct 
and complete. If necessary, edit any records according to the instructions on p.16. 

When you have finished 
making your selection, scroll 
up to the top of the page and 
click the Folder View link (on 
the right-hand side of the 
screen). 

Click the Select 
box, so that all the 
records are ticked. 

Click the Export icon. 

Click the Direct 
Export to EndNote, 
ProCite … button, 
 
then click the Save 
button. 
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Automatic import of PDF articles 

 
EndNote can locate and import fulltext PDF articles. Select one or more references, a group, 
or your entire library and have EndNote scan for fulltext available to you. When the fulltext is 
found, EndNote downloads it and links it to the appropriate reference automatically. 
 
Please note that the success of this facility will depend on which database you got the 
references from, and whether we have access to the fulltext articles. It will also be more 
successful when you are using a University-network PC, as the system will recognise that you 
are entitled to fulltext access. 
 

 
 

 

 

 

 

 

 

Click on one of the items in the Reference List area, so that it is highlighted, then go to the Edit 
menu and choose Select All.   
This will highlight all the references in the list. 
 
Alternatively, you can select individual records by holding down the <Ctrl> key while you click on 
them. 

Click the Find Full Text icon.  
 
A copyright notice will be 
displayed - click the OK button. 
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PDF automatic renaming 

 
If you wish, you can set EndNote to rename your PDF files when they are imported, so that 
they have uniform and meaningful file names. 
 
Go to the Edit menu and select Preferences. 
 

 
 
 
 

 

 

 

 

 

Wherever possible, EndNote will rename your files in the format you have chosen. 

If the download has been successful 
you will see a paperclip icon in the 
Reference List, which indicates there is 
a file attached. 
 
If EndNote is unable to attach the PDF 
file it will attempt to find and attach 
URLs to your records. These can be 
used to return to the fulltext article on 
the database where it was found. 

To read the PDF file click so its record 
his highlighted, then click the Open 
File icon (yellow folder). This will open 
the attachment in a new window. 

Click PDF Handling,  
then select the option you want for 
your filenames. 
 
Click the OK button. 
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Attaching PDFs manually 

 
If EndNote cannot find and attach the PDF for you automatically (see pp. 18-19) you can save 
the file then attach it to the reference manually. 
 
Before you start save the file to your PC.  
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you insert a PDF file or an image, EndNote copies the file and places the 
copy in a .DATA folder, which is found in the same folder as the main library file.  
If you move your library to a different computer, or if you want to share your 
library with someone, remember to always copy the .DATA folder along with the 
library. 

Open the record you wish to use. 

 

Scroll down to the File Attachments field, 

and right click in the space below it. 

Go to File Attachments 
and select Attach File. 

 

Browse to where 
you have the file 
saved, then click 
the Open button.  
 

The file will now be attached to the 

EndNote record.  

Double-click on the PDF icon to open it. 
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Importing PDFs to create new records 

 
EndNote allows you to convert existing collections of PDF files into EndNote records, by 
extracting DOI information from the PDF files, matching it with data from CrossRef 
(www.crosssref.org) and capturing bibliographic content. 
 
 
Therefore, to work, the article will need to have the 
DOI number printed on it somewhere. 
 
 
 

 

Before you start you should your PDF files into a single folder – this will make the importing 
quicker. 

 

 

 

 

What is a DOI? 
A DOI (Digital Object Identifier) is a unique string of characters used to identify an electronic journal 
article or (less frequently) an electronic book. Unlike a URL, a DOI is permanent – therefore using a 
DOI in a bibliographic reference provides a persistent link to the article. 
 
To retrieve an article where you have the DOI, turn it into a URL by preceding the DOI with the 
following: 

http://dx.doi.org/  
 
e.g.  http://dx.doi.org/10.1080/02713680902866972 

 

Go to the File menu, 
 
and select Import. 

Select Folder. 
 
(If you only have one PDF 
file to import, select File). 

http://www.crosssref.org/
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Click the Choose button and 
browse to the folder where 
you’ve got your PDF files saved. 
For this exercise, go to: 
F:\endnote examples\ 

Select PDF from the Import 
Option menu (if it is not already 
selected). 
 
Click the Import button. 

The PDF files will be imported (you can see this from the paperclip icon) and the 
records will be created from the information in each file. 

Use the Reference tab to make any 
changes you want, or to add information  
 
– for example, you may wish to use the 
full journal title. 
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Automatic import of PDFs  

 

EndNote X7 has a new feature which allows you to specify a folder, then whenever you save 

PDFs into it, they will convert into EndNote records automatically. As described on p. 20, the 

articles will need to have DOIs printed on them to work correctly. 

 

 

 

 

 

In EndNote, go to the Edit menu and select Preferences. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

After EndNote runs the import operation, EndNote creates a subfolder called Import within 
your “Auto Import Folder”. This helps you (and EndNote) keep track of what has already 
been imported into your library. 

Make yourself a folder.  
When you are searching for articles save 
the PDF files into this folder. 

Go to PDF Handling. 

Tick the Enable automatic 
importing box. 

Click the Select Folder button 
and browse to the location of 
the folder. 

Click the OK button. 
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Annotating PDFs  

 
EndNote allows you to easily view and annotate the PDFs you have attached to your 
references. 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Open the record you want to use, 
then click the PDF tab. 

When you have finished making all your 
annotations click the Save icon to save 
your changes. 

This will open a box 
where you can type 
your comments. 
 
When you have 
finished click the red 
cross in the corner to 
close the comment 
box. 

Use these icons to Save, Print or Email 
the PDF and your annotations. 

Use the Highlight icon if 
you wish to highlight any 
text. 

If you would like to write any comments on the PDF click 

the Sticky icon, then click where you would like to write 

your comment. 

A balloon will appear.  

Double-click on it. 
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If you import a PDF (see p. 20) that doesn’t have a DOI it will create an EndNote reference 
that looks like this. The file will be attached to the record, but the only information that has 
been captured will be the filename, which is used as the title. 
 

 
 
 
 
 
 
 
 

 
 
Or you might prefer to search for the record again, and import the reference from a 
database or Google Scholar. 
 
 

Importing references from Google Scholar 

 
Open Internet Explorer and go to http://scholar.google.co.uk/ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

If you want to edit the record, alternate 
between the PDF tab and the Reference 
tab to copy and paste the information 
into the appropriate fields – see pp. 9-10 
for more information. 

Click the Settings link at the 
top of the screen. 

Scroll down to the bottom of the 
page, and select EndNote from 
the Bibliography Manager menu. 

Click the Save button. 
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Remember that Google Scholar is a free resource, and therefore you will not get the same 
quality of information that you would from a subscribed database. Check the record you 
have imported and correct any errors or omissions. 
 
 

Using the online search for book records 

 
The EndNote Online Search function allows you to connect directly with a database, search 
that database from within EndNote, and retrieve the results directly into EndNote. 
 

Warning 
With the majority of databases, this method of finding references does not work: the 
technology behind the connection files often fails, and even when it does work, the EndNote 
search form is limited, making it hard to refine your search. 
 
Therefore we do not recommend this method of retrieving records into EndNote. Generally, 
you will have more success if you search a database through its own search form, and then 
export the results into EndNote. 
 

 

From now on, when you search 
Google Scholar, there will be an 
Import into EndNote link after each 
record.  
 
Click this link, 
 
then click the Open button. 
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Click the British Library link.  
 
If it is not already visible click more… 
and select it from the list. 
 

A search form will open.  Type in the details for the book you want. 
 
Note: all matching results will be retrieved into EndNote, so your search should 
be as specific as possible. 

Click the Search button. 

If your search has 
been successful you 
will see a box like 
this. 
 
Click the OK button. 

If Online Search is not already displayed 
in the Groups panel click the Integrated 
Library & Online Search button. 
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The items retrieved from your search will be displayed in the Reference List pane. 
 

 
 
 
 
 
 
 
 
 
 
 

 
  
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

Click to highlight any of the records that you do not want to keep.  
Right-click on the highlighted area and select Move References to Trash. 
 
You can also use the <Delete> key to delete references. 
 

Any remaining records will be retained in your All References folder. 

 

Note: If your search retrieves too 
may results you do not have to 
import them all into EndNote. 
 
Click here and type in a more 
manageable number, e.g. 20, 
then click OK. 
 



 
30 

Part 4 : Organising Your References 
 

Using groups 

 

Groups make it easy to break a large library into subsets for later viewing. A group simply 
points to a subset of references that already exist in the library. 
 
There are several types of groups that make it easy to organise your references in EndNote. 
Some of these groups are automatically generated and some are ones that you can create 
yourself. You can further organise your references by storing multiple groups in custom 
Group Sets. 
 
Some things to note about using groups: 
o You can create a maximum of 500 Custom Groups and Smart Groups (combined) in a 

single library. 
o A single reference will never appear more than once in a particular group. However, you 

can add that reference to any number of groups. 
o Removing a reference from a custom group does not delete it from the library. It removes 

the reference from the group subset, but the reference still exists in the library. 
o Deleting a reference from a library also deletes it from all groups in that library. The 

reference no longer exists. 
 
 

Creating a custom group 

 

You can create custom groups as you wish, in order to organise your references. You might 

wish to make groups for each chapter of your thesis, or for different papers you are working 

on. 

 

 

 
 
 
 
 
 
 
 

 

 

  

 

Go to the Groups menu 
and select Create Group. 
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A box will appear in the Groups 
pane. 
Type in a descriptive name for the 
group you have just made. 
Click away from the box to save 
the name you have just typed. 

You can also file references by right-clicking on the one 
you want, going to Add References to, then selecting 
the group you want. 

You can then start filing references in groups by dragging and 
dropping them from the Reference List pane onto the group name. 
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Creating a smart group 

 
Smart groups are built with search strategies, for example, works by a particular author or 
matching some subject keywords. Smart groups are dynamically updated as you add 
references to and edit references in the library.  
 
 

 
 
 
 
 
 
 
 

 
 

 

 

 

 

Any references you have in your EndNote library which 
match the search criteria for your Smart Group will 
automatically be filed in the Group, as will any future 
references you add. 

 

 

 

Go to the Groups menu and 
select Create Smart Group. 

Type in keywords that will match 
some of your references. 
Select Any Field from the menu. 

Click the Create button. 

Type in a descriptive 
name for your group. 
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Creating a group set 

 

If you make custom groups and/or smart groups to help you organise your references, 
before long you might end up with a large number of groups. To help you organise your 
groups you can create group sets. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

From the Groups menu 
select Create Group Set. 

Give your group set a name. 

Use your mouse to 
drag a group and drop 
it underneath the name 
of the group set. 
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Duplicate records 

 
As you add more an more references to your EndNote Library, from a variety of databases, it 
is likely that you will get duplicate records for the same item. 
 
To avoid anomalies in your citations and references once you start adding them to your Word 
document, you need to ensure that you only have one record for each item. (This is another 
reason to only use one EndNote Library). 
 
o Go to the References menu and click Find Duplicates. 
o Any duplicate records will be displayed, with the areas of differing text displayed. This will 

help you decide which record you wish to keep. 
o Generally, you should keep the older record, as this is likely to be the one you have 

edited, added attachments to, and most importantly, already used for citations in your 
document. 

 
 

 

 

 

Note that the criteria used by EndNote to identify duplicate records won’t always catch all of 
them. You will still need to look through your Library and delete any records you don’t want. 
It is probably easiest to do this if you sort your Library by ‘Author’. 

If necessary, you can copy & 

paste information from your 

‘reject’ record into the one 

you want to keep – for 

example, the more recent 

record may have a DOI. 

When you have finished any editing, click the Keep 

This Record button for the one you want to keep. 

The other record(s) will be sent to Trash. 

You can tell which is the older record by 

looking at its record number (preceded by  #). 
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Part 5 : Cite While You Write 
 
EndNote works with Word to easily and quickly cite references, and create a paper with 
properly formatted citations, a bibliography, figures, and tables. 
 
This is all done using the “Cite While You Write” (CWYW) toolbar, which you will see in Word 
once you have installed EndNote on your PC. 
 
 
 

 

 
 

If you cannot find the CWYW toolbar please contact the ITS Service Desk, at: 
its-servicedesk@salford.ac.uk   
- it is possible the EndNote program has not installed correctly on your PC. 
 
 

Inserting citations & bibliographies into a document 

 
 
1. Open your EndNote library. 
2. Open the Word document called endnote essay, which can be found in the EndNote 

Examples folder on the F: drive. 
 
 
 

 
 

The EndNote toolbar will look like this. It will either 
be a separate tab on the ribbon, or be installed in 
the Add-ins tab. 

3.  In the document click the place where you wish to 
place a citation in the text. Remember to leave a space 
between the last character and your cursor, and that 
your citation is placed before the fullstop at the end of 
your sentence. 
 

4.  Click the Go to EndNote button. 
This will open your EndNote Library. 
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In EndNote: 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

5.  Click once to highlight 
the reference you want 
to use.  

6.  Click the Insert Citation button. 

7.  Return to your Word document.  
You should see a citation that looks like this – the brackets { } and the number 
# indicate this is a temporary citation. 

9.  Select the style you want from the menu.  
 
If you are not sure which one to use, see the 
section “Which style to use” on the next page.  

8.  To format your citation and bibliography 
click the Instant Formatting is Off button and 
select Turn Instant Formatting On. 
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10.  You should now have a correctly 
formatted citation,  
 
and a bibliography at the end of your 
document. 
 

Which style to use? 
 
There are two major systems of referencing: Numeric, where citations in the body of your text 
are indicated by numbers; and Author-Date (also known as parenthetical or Harvard), where 
the in-text citations are in the form of the author & date of the article enclosed in parentheses.  
Within these two main systems there are many different styles. 
 
o A PhD thesis is a peer-reviewed document, and therefore: 

 You should use a referencing style that conforms to good publishing practice in your 
particular academic discipline.  

 The style should be consistent throughout the thesis. 
 Your supervisor will be able to advise you which style you should use. 
 
o Academic journals often have their own referencing style and generally you will be able to 

find it, either already installed in EndNote, or available for download from the EndNote 
website at: http://www.endnote.com/support/enstyles.asp  

 
o You should also find out what is required by looking at the journal’s “instructions for 

authors” page, which you will find either within the journal or on the publisher’s website. 
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Editing citations 

 
Once a citation is inserted in your text you may need to edit it, for example, depending on 
whether you have used direct or indirect quotations, or have paraphrased or summarised 
your sources. 
 
To edit citations you should use the EndNote 
tools, rather than editing directly with Word.  
 
This is because there is a large amount of coding 
behind each citation which may become 
corrupted if you type directly into it. 
 
 
 
 

Direct quotations and page numbers 

 
Many referencing styles require that a citation for a direct quote (or one where you have 
only changed the words slightly) must include the page number where you found it. 
 
Page numbers are not required if you have paraphrased a source, however may still wish to 
include them – they will help your reader pinpoint where you found an idea, especially in a 
long work, such as a book or thesis. 
 

 

 

 

 

 

 

 

 

 

 

 

 

  

Remember that a direct quote should be placed in quotation marks,  or 

indented from both margins if it is longer than two or three lines. 

Click on the citation you wish to 

edit, so that it is highlighted. 

Click the Edit & Manage Citation(s) 
button on the CWYW toolbar. 
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Note: the EndNote templates for many styles are not set to accept page numbers as 
described above. If this is the case with style you have chosen you can still use the Edit & 
Manage Citations button to add a page number, but you will need to type it into the Suffix 
field.  

 

 

 

 

Check that the 
correct citation 
is highlighted. 

Type in the page number(s). You do not need to 
include p. or pp. – EndNote will do this for you. 
Click the OK button. 

The correctly formatted page 
number will now be added to 
the citation. 

This is a free text field, so you will 
need to type in the punctuation and 
p. or pp. before the page number(s).  
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Changing the citation format 

 

In your writing you will often integrate the author’s name into your text, for example: 
 
 Wrigley & Fagg (1989) described the … 
 
In this case, you do not repeat the authors’ names in a citation at the end of the section.  
 
 

 

 

  

 

 

 

 

 

 

 

  

 

 

 

 

 

 

To format your citation this 
way, place your cursor where 
you want the author’s name 
to be – usually this will be at 
the start of your paraphrase. 

Highlight the reference you want, 
then click the Insert Citation button. 

Right-click on the citation you have 

just inserted,  

 

go to Edit Citation(s) 

 

and select Display as: Author (Year). 

Right-click on the citation you have just 
inserted,  
 
go to Edit Citation(s) 
 
and select Display as: Author (Year). 
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There may also be times where you have mentioned both the authors and the date of an 
article in your text, (for example, In his paper of 2008, Fourie reported that ….)  and therefore 
do not need either in your citation. You do still need the reference in your bibliography, and 
you should use EndNote to insert this. 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

Your citation will now be correctly formatted, i.e. authors’ names incorporated into the 
sentence, separated with the word ‘and’, and followed by the date in parentheses. 

You may need to edit the wording so it forms a grammatically correct sentence. 

Type the year and author into your text. 

Place your cursor where you would normally add the citation, i.e. at the end of the 
sentence.  
Go to EndNote and add the citation in the usual way (see page 35, steps 5 & 6). 

Right-click on the citation 
you have just inserted. 

Go to Edit Citation(s), then select 
Show Only in Bibliography. 
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Adding multiple citations 

 

There will be times when you have summarised the content of two or more different papers 
into a single sentence or paragraph, and will need to insert a multiple citation. 
 

 

 

 

 

 

 

 

 

 

The citation will be removed from your text, but the  coding remains 
which ensures that the reference will stay in your bibliography. 

In your document, place your cursor 
where you need to put the citation. 

In EndNote, hold down the <Ctrl> key while you select the references 

you wish to cite, then click the Insert Citation button. 
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Creating secondary citations 

 
There are times that you will find something referenced in a book or an article that is so 
useful or interesting you want to use it in your own writing. This might be a citation for 
another article, or an illustration, graph or table take from another work. 
 
Generally, you should try to find and read the original work and use that as the source of 
your citation and reference. However, there are times when this isn’t possible, for example, 
you may not be able to get hold of the original work, it is in a language you can’t read, or the 
citing author has summed up the ideas in the original more succinctly or elegantly than you 
could ever manage. 
 
When you use a secondary citation like this, your in-text citation should mention both works 
but your bibliography only includes a reference for the work you have actually read yourself. 
You can use the CWYW tools to format a citation in this way. 
 
 

For example, you might wish to use 
this idea, attributed to Lamont and 
Groom in an article you have read by 
Mibus and Sedgley. 
 

 
 
 
 
 
 
 
  

 

 

 

The multiple citations will be inserted in your document in the correct format – in this case, all 
three articles are enclosed in one set of parentheses, in alphabetical order and separated by 
semicolons. This will vary according to the reference style you have chosen. 

Insert the citation for the article you have read, 
following the instructions on p. 35, steps 5 & 6. 
Click on the citation so that is highlighted. 
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You could also format your citation in this way by typing the cited authors into your text, 
then using the Edit & Manage Citations button to insert 1998, as cited in . 
 

 

 

Click the Edit & Manage Citations button. 
 

Make sure the correct citation 
is highlighted. 
 

In the Prefix field, type in the authors and the 
year for the work you have seen cited plus the 
words ‘as cited in’. Remember to leave a space 
after the last word. 
Click OK. 
 

This will format the secondary citation and add 
the correct item to your bibliography. 
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Deleting citations 

 

Because of the large amount of coding behind each citation you insert, you cannot simply 
remove a citation by using the <Delete> key. Nor can you delete a citation you have put in the 
wrong place by using the ‘Undo’ button in Word. To remove a citation you must use the 
CWYW tools. 
 

 

 

 

 

Inserting images into your document 

 

To insert an image into your document first press the <Enter> key once or twice to make a 
space where you want the image to go. 
 
 
 
 
 
 
 
 
 

Click on the citation so it is highlighted, then 
click the Edit & Manage Citations button. 
 

Click the arrow on the Edit Reference button, 
and select Remove Citation.  
Click the OK button. 
 

Click the small arrow on the Insert 
Citation icon on the EndNote ribbon,  
then select  Insert  Figure from the 
menu. 
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Depending on the bibliographic style you 
have chosen, the image you have just 
inserted may be displayed in “List of 
Figures” at the end of your document, 
with a Figure reference in your text – as 
in these examples. 
 

In other bibliographic styles, the image will be displayed 
in the body of your text. If you wish, you can edit your 
Output Style in EndNote to determine how images are 
displayed. 
 
Whenever you use illustrations, graphs, tables, etc. in 
your writing you should explain the purpose of them, 
and cite them as you would for any other literature you 
have used. For more information see the ‘Referencing 
Images’ guide at 

http://www.salford.ac.uk/library/help/userguides 
 
You should have separate bibliographies for ‘Lists of Figures’ and ‘Lists of Tables’. EndNote 
doesn’t generate these automatically, so to create them follow the instructions on the next 
page, Exporting  a Bibliography. 

A search form will be displayed. Type in a keyword 
(e.g. from the caption you gave the image) and 
click the Find button. 

A list of matching image references will be displayed. 
Highlight the one you want and click the Insert button. 
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Exporting a bibliography 

 
Sometimes you may wish to use EndNote just to produce a bibliography for you – for 
example, you may prefer to type your in-text citations yourself, or you may wish to create a 
separate list of illustrative material (see p. 45). 
 
This can be done within your EndNote library; the exported bibliography may then be copied 
and pasted into your document. 
 
 
 

 
 
 
 

 

 

 

  

 

 

 

 

 

 

 

1.  Click on All References or the Group 
you want to create your bibliography from 
(e.g. this Group could be for a chapter of 
your thesis or for your images). 

3.  Click the Export button. 

2.  Select the references you want included in the bibliography, either by holding the 
<Ctrl> key while you click on them, or by using <Ctrl><A> to select all. 

4.  Give your file a name, and select Rich Text Format (.rtf) from the Save as type 
menu.  
Note you must choose RTF otherwise your bibliography won’t have the correct  
formatting. 

5.  Select the Output 
style you want from the 
menu. 

6.  Click the Save button and select 
where you wish to save the file. 
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Electronic submission 

 
If you need to submit your thesis, assignment or article electronically, or want to email it to 
your supervisor, colleague or publisher, you need to remove the EndNote coding from the 
document first.   
 
If you do not remove the field codes before sending your document, they are likely to receive 
something that looks like this: 

 
 
 
 
 

 

 
You will be prompted to save the document with a different name – do this. The copy you 
have just made has no EndNote coding in it and is suitable for emailing and other electronic 
transfer. 
 
If you need to edit your document or continue writing use your original document for this, 
i.e. the one that does have EndNote coding in it. 
 
 
 
 
 
 
 

 

Click the Convert Citations and 
Bibliography button. 
 

Click the Convert to Plain Text. 

 

Tip! 
 
If your own document suddenly looks like the above example, 
press the <Alt> and <F9> keys at the same time to restore it. 
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Part 6 : PowerPoint 
Endnote X7 also has tools to insert citations and references in a Microsoft Powerpoint 
presentation.  Please note that this functionality is only available for Windows. 
 

 

 

 

 

 

 

 

 

 

 

 

 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

1.  Create a Text Box where you want 
your reference(s) to go. 

4.  Select the style you want from the 
menu. 
5.  Click the Insert Selected 
Reference(s) button.  
The references will be inserted in the 
Text Box. 

If you wish, you can also 
put citations into your 
text, by using the Insert 
Citation button. 

1.  Create a Text Box where you want 
your references to go. 

2  Click the EndNote X7  tab in 
PowerPoint. 
3.  In your EndNote Library, click to 
highlight your reference (see p. 35). 
 

If you wish, you can also 
put citations into your 
text, by using the Insert 
Citation button. 
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Please note: the EndNote tools in PowerPoint do not have the same level of functionality as 
those in Word, so if you need to change your style, or edit citations or references, you will 
need to delete them and start again.  

 

 

 

 

Part 7 : Getting Help 
 

o If you need advice about obtaining or installing EndNote please contact the ITS Service 

Desk: 

 email: its-servicedesk@salford.ac.uk  

 phone: 0161 295 2444 

 

o For any help using EndNote please contact Anne Sherwin at:   a.sherwin@salford.ac.uk  

 

o The EndNote website provides a huge amount of help, including online tutorial guides 

and videos, FAQs and a Knowledge Base, a user forum and Customer Support: 

http://www.endnote.com/  

 

 


